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Color 
management

TURNING TO OUTPUT  devices, you may 

work on an image using an LCD or CRT 

screen whose colors differ, subtly or more, 

from the factory-defined specifications; 

someone may just have pressed the 

monitor’s little buttons and the little shift to 

red went unnoticed. We’re also dealing with 

light being emitted from the device. Equally 

two printers of the same model may remain 

within manufacturing tolerance yet output 

color different enough to be visible—and 

that’s before we add to the mix the huge 

range of third party paper, even inks, which 

you might be using in your printer. Again,  

the printer has to process color data in its 

own way, and the final print will have its  

own color characteristics.

An imaging system almost inevitably 

includes a number of devices with differing 

technologies, different ways of assessing and 

managing color. So a Canon digital camera 

needs to sample the scene’s colors and 

record them in red, green, and blue values, 

and in the format required by the camera’s 

own operating system. The Epson inkjet 

printer also has its own proprietary operating 

system and ultimately needs to break down 

color information until it is able to send 

appropriate instructions to the ink nozzles. 

In other words, color is “device dependent.”

Stuck in the middle of all these devices, 

somehow your computer needs to reconcile 

all this device dependant color. As if it wasn’t 

challenging enough to carry the original 

scene’s colors all the way through to the final 

print, the computer needs to deal with many 

permutations of input and output. The final 

image may consist of a digital photograph 

plus artwork that has been scanned or 

created in a drawing package such as Adobe 

Illustrator. As well as merging multiple 

inputs, the output may well be destined for 

multiple devices . You might want to print 

using more than one printer, or perhaps 

display it on an electronic picture frame,  

not to mention the web and PDF.

What is needed is a way to move the color 

information through the various devices in 

an accurate, predictable, and efficient way— 

a Color Management System. This can be 

broken down into two key requirements;

the first of which is a color space that is 

device-independent—the “Working color 

space.” The second is a way to accurately 

describe the color characteristics of each 

camera, printer, scanner, monitor, and so 

on—the ICC profiles. The third is a means  

of exploiting profiles so that each device’s 

color information (the device-dependant 

color) can be translated through the system. 

Many have already offered varies analogies 

for color management—that it’s like a chain, 

or perhaps building blocks. Personally I prefer 

to think of it as stepping stones, all of which 

are necessary to place your foot on accurately 

to make it across.
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The need for color management starts to  

become obvious once you consider the number of 

devices that need to work together in an imaging 

system. The input might come from a digital camera, 

or perhaps a film scanner if our starting point is a 

negative or transparency, while a flatbed scanner 

would be needed for scanning in other artwork. Each 

has its own way of recording color as digital data.
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You can shoot and store a picture 
on an Epson camera and output 
it onto an Epson printer using 
Epson inks and paper, yet such 
closed systems are better in 
theory than in practice.

A scanner 

Typical digital SLR

Epson digital camera

Outside the loop
Stepping away from the closed loop, there are 
even more opportunities for color confusion,  
If you have a camera from one manufacturer 
and a printer from another (not to mention a 
computer graphics card and a computer display 
somewhere along the line) then there are 
certain to be further difficulties.

P7000 portable hard drive 



Scanner

Monitor

Inkjet 
(software is 
often RGB, 
not CMYK)

Proofer

Press

Camera

Computer

Color spaces  
and gamuts

THERE ARE THREE  main types of ICC 

profile: input, display, and output. 

Input profiles are for input devices such as 

cameras or scanners, which capture color, 

the first step in the process. To produce an 

input device profile requires accurate 

information about the real color of the 

original object—this means the use of a 

reference target of known colors against 

which the capture’s RGB values can be 

modeled. Profiles for scanners are common, 

as they are self-contained units with their 

own light sources, but it’s less common to 

profile cameras because lighting conditions 

vary. The profile would only tell you what the 

camera’s color characteristics are in those 

lighting conditions. Unless you can repeat 

them, for instance in a studio, camera 

profiles have little value.

Display profiles are for computer monitors  

or TV screens, while output profiles are for 

printers, from desktop inkjets to commercial 

offset and digital presses. As we will see on 

the following pages, these profiles are 

created by measuring the device’s output—

the monitor or the print—against known 

values. Monitor profiling has been a do-it-

yourself task for a few years, while printer 

profiling is still on a twin track. Custom  

color profiles are available from vendors or 

remote profiling services, or you can make 

your own if you can justify the cost of the 

equipment needed. 

With each device having a profile, things take 

shape. Photoshop or other ICC-aware imaging 

software can control colors by reading any 

profile already embedded in the image. It can 

read the monitor profile and understand 

what colors you are seeing on screen. When 

you tell it you are going to print the image on 

your Epson 2880 using Premium Luster 260, 

the printer profile gives it the information  

to convert the image’s color data into the 

instructions needed by the printer. 
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An ICC color profile is a file that describes  

a particular device’s color characteristics and how  

it captures or outputs color values. They are often 

known as ICC profiles after the International Color 

Consortium (http://www.color.org/), the industry 

body that creates, promotes, and standardizes the 

vendor-neutral, cross-platform, color management 

architecture and components. 
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Color management is about taking color 
data from one device to another—from 
an RGB capture to an inkjet printer with 
any number of inks.

A color chart, printed so devices 
can be tested against its purity.

In a color management system 
each device, whether it works  
in additive (RGB) or subtractive 
(CMYK or variants) color, has  
it’s own color profile, indicated  
by the gamut icon.

INPUT DEVICE SPACE
PROFILE 

CORRECTION 

SPACE

INPUT 

DEVICE 

PROFILE

OUTPUT 

DEVICE 

PROFILE

OUTPUT DEVICE SPACE

Management 
approach
Remember my stepping stones 
analogy? With color management 
you’re jumping between irregular 
objects and can easily slip. But you 
can see where you’re going and 
with a bit of care you can get there. 



Monitor 
calibration

Calibration
Serious photographers budget for devices 

such as the Eye-One Display from Gretag 

Macbeth, the Spyder, or the more recent 

ColorMunki. These combine a colorimeter 

with dedicated software. Whichever model 

you choose, the color consistency of your 

prints will show a marked improvement.

Before beginning calibration, allow the 

display to warm up. A screen’s color 

characteristics are not always the same 

when it is cold, and it should be allowed  

to settle at its working temperature.

Another preparatory step is to disable any 

screen savers or energy management settings 

on the computer, because you don’t want 

them to kick in while the colorimeter is 

doing its calibration work. It is equally 

important to keep the screen away from 
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The single most important step in color 

management is calibrating your monitor. If the 

computer doesn’t know how it is displaying the 

colors that you are seeing, it’s going to have a hard 

job translating them into accurate instructions for 

the printer. Both the Mac and Windows operating 

systems now include color calibration utilities that 

allow you to calibrate the display with your own eyes, 

but for a more dependable scientific approach you 

really need to consider a colorimeter. 

S
E

T
T

IN
G

 U
P

 Y
O

U
R

 C
O

M
P

U
T

E
R

Post-calibration
After you have calibrated  
the monitor the first time,  
it’s a process that should be 
repeated every so often. Each 
time you change the monitor’s 
settings, you will probably 
remember to recalibrate,  
but you may not be aware  
if someone else alters the 
brightness when you are 
absent. The monitor’s 
performance characteristics 
may also change over a period 
of time, or occasionally a color-
managed program may suddenly 
start displaying weird colors—a 
sign of a corrupt monitor profile. 
To deal with such eventualities, 
some photographers recalibrate 
their monitors every month. 
You can ask your computer to 
remind you to do so. It’s a quick 
job and soon becomes a habit.

A screen from the ColorVision 
calibration software. As you can 
see, the device keeps you 
informed about the settings 
you’re using.

Monitor calibration devices  
like this one need to be rested 
against the screen. Once in place, 
the software will commence 
showing it a series of colors.

lamps or windows, and it’s a good idea  

to switch off lights and perhaps close  

the blinds.

In general, all these devices give you a series 

of on-screen instructions, that need to be 

followed. Usually you are told to place the 

colorimeter on your monitor and then the 

software sends a series of test colors to the 

screen. The device measures how the monitor 

is outputting these colors and, after 5-10 

minutes, creates a color profile.

Next steps
Most calibration devices automatically save 

the new monitor profile in the correct folder 

for Mac or Windows and also set it as the 

current profile. The next step is to use the 

profile in Photoshop or other imaging 

software. Your photos should already look 

more accurate on screen.

Place sensor on the screen as shown.
Suspend the device from the top of the 
screen. Do not use suction cups on LCD. 
When the instrument is positioned, click 
Continue.

press esc to cancel

Continue

Cancel

Current Settings

To adjust the display to the settings shown below, mark the appropriate radio button 
and click the right arrow to continue.
To change the settings, mark the appropriate radio button and click the right arrow to 
continue.
For a complete explanation, click the Help button.

Display type:
Display:

LCD
1-Color LCD

2.2
Native

Visual
na
na

Gamma:
White Point:

Luminance Mode:
Black Luminance:
White Luminance:

Last Calibrated:
Current Profile:

14:03 2/11/07
Color LCD Calibrated 071102.icc

Continue with these settings
Change these settings

Help Back Next



1	
A1	

0.00	 0.00	 0.00

2	
A2	

0.00	 32.00	 0.00

3	
A3	

0.00	 64.00	 0.00

4	
A4	

0.00	 96.00	 0.00

5	
A5	

0.00	 128.00	 0.00

6	
A6	

0.00	 160.00	 0.00

7	
A7	

0.00	 192.00	 0.00

8	
A8	

0.00	 224.00	 0.00

9	
A9	

0.00	 255.00	 0.00

10	
A10	

0.00	 0.00	 32.00

11	
A11	

0.00	 32.00	 32.00

12	
A12	

0.00	 64.00	 32.00

13	
A13	

0.00	 96.00	 32.00

14	
A14	

0.00	 128.00	 32.00

15	
A15	

0.00	 160.00	 32.00

16	
A16	

0.00	 192.00	 32.00

17	
A17	

0.00	 224.00	 32.00

18	
A18	

0.00	 255.00	 32.00

19	
A19	

0.00	 0.00	 64.00

20	
A20	

0.00	 32.00	 64.00

21	
A21	

0.00	 64.00	 64.00

22	
A22	

0.00	 96.00	 64.00

23	
A23	

0.00	 128.00	 64.00

24	
A24	

0.00	 160.00	 64.00

25	
A25	

0.00	 192.00	 64.00

26	
A26	

0.00	 224.00	 64.00

27	
A27	

0.00	 255.00	 64.00

28	
A28	

32.00	 0.00	 0.00

29	
A29	

32.00	 32.00	 0.00

30	
A30	

32.00	 64.00	 0.00

31	
A31	

32.00	 96.00	 0.00

32	
A32	

32.00	 128.00	 0.00

33	
A33	

32.00	 160.00	 0.00

34	
B1	

32.00	 192.00	 0.00

35	
B2	

32.00	 224.00	 0.00

36	
B3	

32.00	 255.00	 0.00

Printer 
profiles

ESSENTIALLY YOU HAVE a couple of choices. 

One is to obtain printer profiles from Epson,  

a third party ink or paper vendor, or from a 

remote profiling service. The other is to build 

your own custom profiles.

Epson profiles
At first, it is sensible to keep things simple and 

stick to Epson inks and paper. The printer’s 

setup disc will install Epson’s ready-created 

profiles on your system, and updated profiles 

can also be found on Epson’s support web site. 

These are usually a good starting point.

Third party papers and inks
Third party vendors obviously want to make 

using their papers and inks as easy as using 

Epson’s own products, so the manufacturers 

or distributors usually supply printer profiles 

at no extra cost, typically as downloads. Again, 

these generic profiles are often all you need to 

start getting great results.

Custom profiling services
Most printer, paper, and ink combinations will 

be covered by Epson or third party profiles, 

but it is quite possible that you may discover 
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With your monitor calibrated, the color management 

chain is nearly complete. Your computer has the right 

information to assess the image’s on-screen appearance, 

and it is ready to translate it into instructions to send 

on to your inkjet printer. It just needs to know a little 

bit more about the intended output. While the computer 

usually detects the printer model and the cartridges, 

printers aren’t smart enough to establish what type of 

paper you are using, and in any case, both printer and 

ink may vary from factory settings. What it needs is a 

definition of the characteristics of your combination of 

printer, ink, and paper—a printer profile.
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On Windows XP and Vista, monitor and 
printer profiles go in C:/windows/system32/
spool/driver/color.

On the Macintosh, the profiles are installed 
into the Library, within the Profiles folder of 
the ColorSync area.

On Windows or Mac 
computers you can get 
information about any 
profile by simply right 
clicking it (if you’re using 
a one button mouse with 
a Mac, Ctrl-click). This is  
a paper profile supplied 
by the paper supplier 
Permajet for one of its 
inkjet papers.

An ICC color profile 
contains a series of 
measurement tables 
like this.

A set of tables ready 
to be sent to a remote 
profiling service.

Where to install printer profiles
Mac OSX - HD > User > Library > ColorSync > Profiles

Windows XP and Vista - C:/windows/system32/spool/driver/color

an exception, or perhaps be dissatisfied with 

a supplied profile’s results. One course of 

action is to buy your own spectrometer (see 

“Colorimeter profiling” on page 66) and make 

your own printer profiles. Often, however, a 

more economical solution is to find a remote 

profiling service, which will create a profile 

just for you.

The process is quick and simple. Some third 

party paper or ink suppliers offer custom 

profiles for free, or you can consult a 

professional printing and color management 

specialist. In each case, you are generally 

given instructions and a target file that you 

put through your printer with the ink and 

paper combination that you want to profile. 

You then mail the print to the vendor or 

profiler, and they use a high quality 

spectrometer to create a unique ICC profile 

for your printing environment. This  

is normally emailed back to you with 

installation instructions. 

color

File    Edit   View    Favorites   Tools    Help

Back

File and Folder Tasks

Other Places

Details

Type: ICC Profile Date Modified: 08/02/2006 12:13 Size: 27.7 KB 27.7 KB My Computer

Go

Per165_r.icm                     Per165_t.icm                      Per245_r.icm                     Per245_t.icm            Photoshop4DefaultCM...

Photoshop5DefaultCM...    PJet_Delta_2100OEMP...     PJetW_2100OEM_Glo...      PJetW_2100OEM_Parc...               ProPhoto.icm

SMPTE-C.icc                   sRGB Color Space                  stdpyccl.icm                Trinitron Compatible        UncoatedFOGRA29.icc
                                            Profile.icm                                                             9300K G2.2.icm   

060208 John’s Spyder
calibration.icm
ICC Profile
Date Modified: 08 February 
2006, 12:13
Size: 27.7KB

Rename this file

Move this file

Copy this file

Publish this file to the Web

E-mail this file

Delete this file

Search Folders Address C:\WINDOWS\system32\spool\drivers\color Library

Library
john
Users
Macintosh HD
John Beardsworth’s Computer

Name
Acrob
Applic
Assist
Audio
Autosave Information
Caches
Calenders
ColorPickers
Colors
ColorSync
        Profiles
Cookies
Documentation
Favorites
FontCollections
Fonts
Icons
iMovie
Internet Plug-Ins
iTunes
Keyboard Layouts
Keychains
LaunchAgents
Logs
Mail
Mail Downloads

1 of 43 selected, 32.01 GB available

View Action

General

P Jet_Delta_21000EMPK_GPP - 1440-Pct.icm Pro...

Color Profile Description:

Color Profile Producer:

Additional Information:

Microsoft Windows 2000 Incorporates:

OK                  Cancel               Apply

LinoColorCMM © by Heidelberger Druckmaschinen AG

Additional information is not available.

(c) 1995-2002 Monaco Systems, Inc

PJet_Delta_2100OEMPK_GPP-1440-Pct

Profile Information Associate Device Summary



Colorimeter 
profiling

A WIDE RANGE of products is available from 

color management specialists like Color 

Confidence, who make the ColorMunki, 

Gretag-Macbeth, Pantone, or Chromix.  

Some products are very expensive, partly 

because they are pitched at press and other 

commercial-scale printing environments, but 

even those suitable to home or small office 

inkjet printers will set you back enough to 

merit a cost-benefit comparison. 

Unfortunately, before making the investment, 

such an analysis can only be approximate. 

You may be able, for instance, to cost the 

time you save getting prints that match your 

quality standards, and paper and ink wastage 

may well come down dramatically, especially 

if you use a variety of third party paper  

and ink combinations. Yet precise numbers, 

if ever possible or truly accurate, will only  

be available in retrospect, and in any case  

it can be difficult to place a value on greater 

dependability of output. How do you ever 

evaluate the psychological benefits of printing 

becoming a more reliable experience? All one 

can say is that you need to go through this 

thought process for yourself and for your 

individual circumstances. While making your 

own printer profiles can, for some, amount to 

a question of whether you can afford it, others 

would ask how a professional setup can afford 

not to do so?
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Making your own printer profile is not difficult,  

but until recently the cost has been a big deterrent. 

While a monitor calibration device can cost less  

than a hard drive, the equipment for creating your  

own printer profiles has cost four or five times as 

much. However, the success of the ColorMunki, a dual 

device combining monitor and printer profiling, has 

been as much due to its lower price as to its features, 

and this seems to indicate that printer profiling will 

soon become almost as common as monitor 

calibration—which will be no bad thing.

While individual profiling products differ  

in many ways, in general they all come with 

hardware devices and supporting software 

for both Mac OS and Windows. You are then 

guided through the process with on-screen 

instructions, and this usually means printing 

a sample page using your chosen combination 

of printer, ink, and paper. 

Often a specially-defined grid of colored cells 

or tiles, you allow the sheet 10-15 minutes’ 

drying time and then follow the instructions 

and roll the spectrophotometer over each 

row in turn. Sometimes a further sample 

page is needed, so the device can measure 

other hues. As soon as that’s done, the 

software generates the printer profile and 

places it in the correct folder for your 

operating system. 

This spectrophotometer is a dual purpose 
device for monitor and printer profiling.  
It measures the full visible spectrum of 
light reflected from color prints or screens.



Photoshop 
color settings
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Now we turn to setting up your image editing software for a color-

managed workflow. With your monitor properly calibrated, and 

printer profiles representing possible combinations of printer, ink, 

and paper, your computer now has the key information about the 

hardware you’re using. Image editing software can get the monitor’s 

profile from the operating system, and translate the on-screen image 

into a print. It just needs you to choose a printer profile and tell it 

which printer, ink, and paper you’re using. 

NOT SO LONG  ago, a book such as this 

would have shown Adobe Photoshop’s color 

management and only mentioned other 

image editing programs in passing. But 

Photoshop’s status as most photographers’ 

main printing application has been 

challenged—or rather complemented—by 

Adobe’s own Lightroom and Apple’s Aperture.  

I say “complemented” because many 

photographers do more complex image 

editing in Photoshop but use Lightroom or 

Aperture to manage their pictures. If you  

do manage images with these programs it 

makes sense to print directly from them 

when you need another copy of an image.

Whichever program you are using, it’s 

important to understand where its color 

management settings are and how to use 

them. So we will look first at Photoshop 

which—given it’s broader user base and 

legacy —has many more options, and  

then we’ll examine the more streamlined 

color management features of Lightroom  

and Aperture.
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Adobe Photoshop, Adobe Lightroom, and 
Apple’s Aperture are three of the most 
popular choices for editing and printing 
photographs, with the latter two 
handling image management too.

LIGHTROOM

APERTURE
PHOTOSHOP

Photoshop’s color settings
Under Photoshop’s Edit menu is the Color 

Settings command. This very important 

dialog box is where you set the working color 

space—the profile Photoshop will use to 

manage color—and in particular the Working 

RGB (the theoretical color space that you are 

using while editing). You need to choose a 

setting that provides the best image quality 

for inkjet printing. It is also where you  

decide how Photoshop should handle any 

differences between your chosen color space 

and whatever profile may already be 

embedded in an image. 

The Color Settings dialog box caters to 

Photoshop’s very wide range of users, not  

just inkjet photo printers. Web designers 

often work in the sRGB color space, while 

commercial press operations focus more  

on CMYK settings—to mention just two 

groups of users. So rather than explaining  

all Photoshop’s settings, the following pages  

will concentrate on getting the color settings 

right for inkjet photo printing.

Settings
Depending on your location, the default 

setting is either North America General 

Purpose 2 or Europe General Purpose 2.  

For inkjet printing it’s better to change this  

to US or Europe Prepress Defaults, but that  

is only a starting point.

Lightroom    File    Edit    Print    View   Window    Help

Preview

Template Browser

Collections

Page Setup...      Print Settings... Print One                 Print...

Layout Engine

Image Settings

Layout

Guides

Overlays

Print Job 

Print to: Printer

240 ppi

Draft Mode Printing

Print Resolution

Print Sharpening:
Media Type:

Standard
Glossy

Profile:
Rendering Intent:

16 Bit Output

Color Management

Managed by Printer
Perceptual

Library  |  Develop  |  Slideshow  |  Print  |  Web

Wed 14:59:23 (100%)

Lightroom Templates
User Templates

2x2 Cells Copyright
3x3 Cells Copyright
Bottom fishing
Bottom fishing 2
Bottom fishing 3
Clive’s 4 up
Contact sheet
JB’s one up

Preset Name

Single Images

Contact Sheet
Sample Contact Sheet Preset

Sample Single Image Preset

Copies & Pages

Print

Printer Selection

Copies:   1

Page:

Printer:

Paper Size:

Orientation:

Gamma:

Sharpen Amount:

Sharpen Radius:

Scale To: Fit Entire Image

0            x   0            cm.

DPI:   363

Layout Options

Border Options

Save As...             Save Hide Loupe           Save as PDF...          Preview

1 image selected - A4 (20.995x29.693 cm.)

Cancel           Print

Width: 1.439     cm.

Print Resolution

Use Best DPI

ColorSync Profile:

All

From:   1          to:  1

EPSON Stylus Photo

Print Settings...

A4

Best Fit

SP2400 Archival

Black Point Comp

1.00

20.995    x  29.

John’s Epson 2400 Delta Matt
John’s Epson 2400 Luster
John’s Epson 2400 FibaPrint
John’s Epson 2400 Hahnemuhle Rag
John’s Epson 4000 Hahnemuhle Rag

Show crop marks

Point Sample Sample:   All Layers

70-Colorimeter-ARPR-aw.tif 90-Colorimeter-ARPR-aw.tif @ 16.7% (RGB/8
HISTOGRAM

ANALYSIS

INFO

SWATCHES

LAYERS     CHANNELS    PATHS

1 pixels = 1.0000 pixels
Eyedropper

R :
G:
B:

C
M
Y
K

X :
Y:

W
H:

8-bit 8-bit

Normal

Background

Opacity:  100%

Fill:  100%

Channel:  RGB

Source:    Entire Image

 Mean: 99.62
Std Dev: 39.47
 Median: 103
 Pixels: 137800

 Level:
 Count:
 Percentile:
 Cache Level: 4



70

S
E

T
T

IN
G

 U
P

 Y
O

U
R

 C
O

M
P

U
T

E
R

71

Color Management Policies
Color Management Policies comes next  

and this is where you tell Photoshop how  

it should deal with any clash between its 

settings and those that may already be 

embedded in an image. Perhaps you have 

files “tagged” with different profiles, before 

you started a color-managed workflow, or  

a picture may have come from another 

computer with different color settings. 

For example, imagine Color Settings shows 

the Working RGB is set to the sRGB. What 

should Photoshop do if you then open an 

image whose profile was the much wider 

ProPhotoRGB working space? Should it 

convert the colors to sRGB? Equally, consider 

a second case where Photoshop has been set 

to work in ProPhotoRGB and the image is a 

JPEG straight from the camera and tagged as 

the narrow sRGB. Should Photoshop convert 

the image data to the wider working space, 

or works with it as it is?

The drop-down box’s choices are quite 

straightforward:

• Off

• Convert to Working RGB

• Preserve Embedded Profiles

Off turns off color management for new 

Photoshop documents and for files whose 

profile differs from the Photoshop’s working 

space. It’s not a good choice if you are trying 

to establish a color-managed workflow.

Convert to Working RGB assumes that the 

working RGB should take priority over any 

profile that may already be in the image. 

In the first example above, this choice would 

convert my wide gamut ProPhotoRGB file into 

the narrower gamut sRGB. That might suit 

someone producing images for a internet 

site, because sRGB is the lowest common 

denominator, which ensures that images look 

OK in whatever browser is being used to view 

them. For the inkjet printer, however, the 

conversion would effectively discard a lot of 

subtle colors and image quality. So it’s not 

the ideal choice. 

But, in the second case, where Photoshop  

is set to ProPhotoRGB, converting an sRGB-

tagged JPEG to the wider gamut Working RGB 

would not do the image any harm and would 

potentially allow you to do more work on it 

without posterization or other damage. If you 

are routinely working with JPEGs or images 

with a narrower profile than ProPhotoRGB, 

the choice of Convert to Working RGB may  

be appropriate.

Preserve Embedded Profiles means that 

Photoshop respects any profile embedded  

in the image. When you open an image 

whose profile differs from the Working RGB, 

Photoshop does not convert the colors but 

leaves things how they are. 

So the ProPhotoRGB image would be opened 

as ProPhotoRGB, even if Photoshop’s Working 

RGB were sRGB. Equally, the JPEG is opened 

as an sRGB image and not converted to the 

wider gamut Working RGB.

While this seems a somewhat 

passive approach, it’s actually 

the choice that leaves you  

the most flexibility, does no 

damage, and doesn’t stop  

you changing the color space 

afterwards. That is why, on 

balance, it is the best  

choice here. 

Also in Color Management 

Policies is a small group of check 

boxes called Color Mismatches. 

These settings are less critical in 

terms of getting color right, but 

are valuable as they allow you to 

balance smoothness of workflow 

against knowing how Photoshop is 

handling mismatches.

Essentially the check boxes tell Photoshop 

whether to prompt you for a decision when 

you open a file whose profile differs from 

Photoshop’s Working RGB.

When you’re first getting used to a color-

managed workflow, it can be a good idea to 

leave all these settings checked. Each time 

Photoshop finds a mismatch, it will ask you 

what to do—use the embedded profile, 

convert it to the Working RGB, or switch off 

color management. The great thing is that it 

forces you to go through the thought process 

each time. 

However, it can be tiresome if Photoshop has 

already been set to respect any embedded 

profiles. Also, after a short while, you’ll be 

confident of what Photoshop is doing. So 

once you reach that point, uncheck them. 

Photoshop detects when an image’s embedded profile 
doesn’t match your chosen color space.

There is a serious risk of a clash 
between printer and printer-software 
managing the colors and Photoshop 
trying to do so. As the reminder 
shows here, only one device should  
do so at at time.

This gamut comparison shows the 
ProPhotoRGB space in cyan, the sRGB 
space in magenta and the Adobe RGB 
space in yellow. 

Notice the Description area at the bottom 
of the Color Settings dialog. As you move 
the mouse over drop-down menus and 
other parts of the dialog there’s a short, 
but often helpful, explanation of the 
settings. Here the More Options button  
in the top-right group is selected.

Working Spaces
Working Spaces is a key group of settings, 
and you have separate drop-down boxes  
for RGB, CMYK, Grayscale, and Spot. These 
correspond to the color modes used in 
Photoshop’s Image > Mode menu. We only 
really need to set the RGB color setting:

• Adobe RGB is a general purpose color 
space and has a wide gamut (range of 
colors). It may appear the obvious choice,  
but it’s not really the best.

• sRGB This is a very common color space 
because of its use for the web and for JPEGs. 
It also has the narrowest gamut of color, so 
you shouldn’t choose it if you want the best 
print quality.

• ProPhotoRGB is another, more modern 
general purpose color space, and it has 
the widest gamut of colors. For this 
reason it’s now generally acknowledged 
as the best color space to choose for 
inkjet photo printing. Unless you have  
a specific reason to the contrary, choose 
ProPhotoRGB.

Unsynchronized: Your Creative Suite applications are not  
synchronized for consistent color.

Working Spaces

Color Management Policies

Conversion Options

Advanced Controls

Description

RGB:

CMYK:

Gray:

Spot:

RGB:

CMYK:

Gray:

Profile Mismatches:

Missing Profiles:

Engine:

Intent:

Ask When Opening

Ask When Opening

Adobe (ACE)

Relative Colorimetric

Ask When Pasting

Preview

OK

Cancel

Load...

Save...

Fewer Options

ProPhoto RGB

Coated FOGRA27 (ISO 12647-2:2004)

Dot Gain 15%

Dot Gain 15%

Convert to Working RGB

Preserve Embedded Profiles

Preserve Embedded Profiles

Use Black Point Compensation

Use Dither (8-bit/channel images)

Compensate for Scene-referred Profiles

Desaturate Monitor Colors By:         20              %

Blend RGB Colors Using Gamma:     1.00

ProPhoto RGB: Provides a very large RGB gamut that encompasses the entire 
range of photographic materials. This is a color space particularly suited for 
output devices such as a digital dye sub and inkjet photo printers, and for 
applications such as HiFi color. ProPhoto RGB is also called “ROMM RGB”  
(see www.pima.net).

Color Settings

CustomSettings:

The document “050617 015162 Derwentwater.tif” has an 
embedded color profile that does not match the current RGB 
working space.

What would you like to do?

Embedded:  ProPhoto RGB

Working:  sRGB IEC61966-2.1

Embedded Profile Mismatch

Cancel                  OK

Use the embedded profile (instead of the working space)
Convert document’s colors to the working space
Discard the embedded profile (don’t color manage)

Color Management

Printer Manages Colors

Printer Profile:

Rendering Intent:

Relative Colorimetric

Black Point Compensation

SP2100 Glossy Paper - PW_PK

Remember to enable color management
in the printer dialog box.

Document

Proof

Color Handling:

(Profile: ProPhoto RGB)

(Profile: N/A)
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Saving Files
One important concept is that Photoshop  

has document-specific color settings. 

The Working Space chosen in the Color 

Settings dialog is for Photoshop’s overall 

environment. It will be used for:

• New documents

• Existing images with no embedded  

ICC profile

• Imported untagged images such as  

those from digital cameras.

When you save a file, the color 
space is embedded inside it.

Here one image is ProPhotoRGB, 
another Adobe RGB (a mono one, at 
that) and another uses sRGB—this  
is document-specific color at work; 
all three can be open at once.

Photoshop’s File > Print dialog box is where 
all the color management work comes together. 
The preview can be in soft proofing mode, via 
the Match Print Colors check box, and other 
settings control print scaling and color handling.

The Color Handling drop-down 
box lets you decide whether 
Photoshop or the printer should 
manage the colors.

Printing
The File > Print dialog box is another 

critically-important area of color 

management in Photoshop. This is where 

everything comes together—the calibration  

of our screen, the printer profiles that 

describe the characteristics of the printer, 

ink, and paper that you are using, not to 

mention the original image’s aesthetic 

quality and post processing work.

Assuming you have got everything right  

so far, this is about the last point where  

it’s possible to take a wrong turn.

Fortunately, a lot of work has gone into 

making the choices as obvious as possible, 

and—since Photoshop CS3—the Print Preview 

dialog box has been color managed and even 

has soft-proofing built-in.

The color management section is on the 

right-hand side of the window where there  

is a drop-down box with two choices. One is 

Output, but for now choose Color 

Document specific color means that each 

individual file has its own ICC profile 

embedded within the document. While 

Photoshop itself has an overall color space,  

it can have open a number of images, each 

using its own color settings. 

Management, and you get a number of 

settings which, not surprisingly, are best 

understood by working from top to bottom.

By default, Photoshop assumes we want to 

print using the image or “document” profile. 

The next setting, Color Handling, is much 

more critical and gives us four choices:

• Printer Manages Colors Photoshop lets the 

printer convert colors from the document to 

the printer’s internal color space. Choose this 

option when you don’t have profiles for your 

printer, paper, and ink combination.

• Photoshop Manages Colors Photoshop 

converts the colors and sends them to the 

printer. This is the choice you must use  

when you are printing profile tests.

• Separations is for printing CMYK separated 

colors, unimportant here.

• No Color Management is not 

recommended when printing pictures.

The first two are the important ones for  

our needs, so let’s look at each in turn.

Save:

Color:

Save As

Save As: Untitled-1.tif

x-arpr-jbd-064-065 Color

TIFF

As a Copy
Alpha Channels Spot Colors

Notes

Layers

Embed Color Profile: ProPhoto RGB

Cancel           Save

Use Proof Setup: SP2100 Archival M...

Where:

Format:

Photoshop    File   Edit    Image   Layer    Select   Filter   Analysis    3D   View    Window   Help

© 071116_059215 Lake District copy 2 @ 25% (RGB/16*) *

© 071116_059215 Lake District copy @ 25% (Black & White 1, Layer Mask/16) *

25%                 © sRGB IEC61966-2.1 (16bpc)

25%                 © Adobe RGB (1998) (16bpc)

25%                        ProPhoto RGB (8bpc)

Version Cue
Document Sizes
Document Profile
Document Dimensions
Measurement Scale
Scratch Sizes
Efficiency
Timing
Current Tool
32-bit Exposure

Show Versions...

Reveal in Bridge...

Show

© 071116_059215 Lake District.dng @ 25% (RGB/16)

Auto-Select:   Group                   Show Transform Controls

25%

Print

Copies:   1

Position

Center image

Top:

Left:

Scale:

Scaled Print Size

Scale to Fit Media

Height:

Width:

Print Resolution: 300 PPI

Print Selected Area

Bounding Box

Units:      cmMatch Print Colors

29.7 cm x 20.99 cm

Gamut Warning

Show Paper White

Cancel                  Done                          Print...

1.075

100%

16.93

25.46

1.393

Page Setup...

Printer:     EPSON Stylus Photo 2100
Color Management

Photoshop Manages Colors

Printer Profile:

Rendering Intent:

Relative Colorimetric

Black Point Compensation

Proof Setup:

Working CMYK

Simulate Paper Color

Simulate Black Ink

SP2100 Glossy Paper - PW_PK

Remember to disable color management
in the printer dialog box.

Document

Proof

Color Handling:

(Profile: ProPhoto RGB)

(Profile: N/A)

Color Handling:

Printer Manages Colors
Photoshop Manages Colors
Separations
No Color Management
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Photoshop Manages Colors
For our purposes, the most likely choice is 

Photoshop Manages Colors. Also known as 

application color management, this method 

is designed for the color-managed workflow 

where the user wants complete control of 

how document colors are rendered. 

Photoshop converts the colors and sends  

the instructions to the printer driver.

Remember I mentioned wrong turns?  

Well, one is here. It is very easy—even for 

experienced inkjet printer users—to overlook 

that the Printer Profile drop-down box 

defaults to the current Working RGB. At this 

point Photoshop has no real idea what paper 

the printer is using. Almost always, the 

Printer Profile needs to be changed to the 

profile that represents the printer, paper, and 

ink combination you are using. Even if you 

haven’t changed anything, always review the 

Printer Profile setting before you click the 

Print button.

Once a printer profile is selected, both  

Rendering Intent and Black Point 

Compensation (BPC) are activated. Generally 

you’ll want to use Perceptual or Relative 

Colorimetric and have BPC checked. It’s 

worth noting that with many of the newer 

models from Epson it is probable that 

choosing Relative Colorimetric will produce 

the more pleasing prints.

Printer Manages Colors
The other important Color Handling choice 

to try is Printer Manages Colors. This makes 

Photoshop leave the document color 

management entirely to the printer driver,  

so Photoshop does not convert the document 

colors or pay attention to whatever paper 

and ink settings may be in the printer driver. 

The document is sent directly to the printer 

driver with tags on how to convert its colors, 

but it is the printer driver that attempts to 

obtain accurate print color.

Experienced inkjet printer users who have 

their own print profiling equipment are  

often able to get better results by creating 

their own print profiles for Epson papers.  

So they, like authors of Photoshop books  

and tutorials, tend to prefer the Photoshop 

Manages Colors route.

Printer Profile is where you tell Photoshop 
exactly what the printer, ink, and paper 
combination you are using. 

When Photoshop’s managing the colors, switch OFF  
the printer driver’s color management.

Too many cooks spoil the broth
Another very important point is that the printer’s own color 
management must be switched off in the printer driver.  
You don’t want the printer fighting Photoshop.

However, Printer Manages Colors is certainly 

worth trying. You would usually choose it in 

two circumstances:

• You are using Epson paper and Epson ink 

and get good results.

• If you don’t have a profile for the printer, 

ink, and paper combination. 

While Epson’s own profiles can be bettered, 

it’s clearly in Epson’s interests to support its 

printers with profiles that let the user get the 

most out of Epson papers and inks. So Epson 

continues to improve the accuracy of its 

supplied profiles and drivers, and updates 

are available on Epson’s web site (www.

epson.com). Printer Manages Colors can 

produce great results.

Notice that choosing Photoshop Manages 

Colors immediately makes available the 

Printer Profile drop-down box. This is 

because Photoshop Manages Colors means 

that you are telling Photoshop to convert the 

image colors and to do so using the profile 

selected in the Printer Profile drop-down box. 

Advanced
Media Type

Premium Luster Photo paper (260)
Ink

Print Quality

MicroWeave

Supr (x)

High Speed

Printer Color Management
Color Controls
PhotoEnhance
Off (No Color Adjustment)
ICM

Flip Horizontal

Fnest Detail

Edge Smoothing

Paper Config Save Settings OK Cancel Help

Fine - 720dpi

Color/B&W

Black

APJ_OEM2100PK_Delta_WCRW_#1
ARRIFLEX D-20 Daylight Log (by Adobe)
ARRIFLEX D-20 Tungsten Log (by Adobe)
CIE RGB
Color LCD
Color LCD Calibrated
Color LCD Calibrated 071102
Color LCD Calibrated 090210
Dalsa Origin Tungsten Lin (by Adobe)
e-sRGB
Fujifilm ETERNA 250 Printing Density (by Adobe)
Fujifilm ETERNA 250D Printing Density (by Adobe)
Fujifilm ETERNA 400 Printing Density (by Adobe)
Fujifilm ETERNA 500 Printing Density (by Adobe)
Fujifilm F-125 Printing Density (by Adobe)
Fujifilm F-64D Printing Density (by Adobe)
Fujifilm REALA 500D Printing Density (by Adobe)
Generic RGB Profile
HDTV (Rec. 709)
John’s Spyder 071102
Kodak 5205/7205 Printing Density (by Adobe)
Kodak 5218/7218 Printing Density (by Adobe)
Kodak 5229/7229 Printing Density (by Adobe)
Nikon Adobe RGB 4.0.0.3000
Nikon AdobeWide RGB 4.0.0.3000
Nikon Apple RGB 4.0.0.3000
Nikon Bruce RGB 4.0.0.3000
Nikon CIE RGB 4.0.0.3000
Nikon ColorMatch RGB 4.0.0.3000
Nikon D1 for NEF v.1.0.0.3002
Nikon DBase for NEF v.3.0.0.3001
Nikon MacMonitor RGB 4.0.0.3000
Nikon NTSC RGB 4.0.0.3000
Nikon sRGB 4.0.0.3001
Nikon WinMonitor 4.0.0.3000
NTSC (1953)
PAL/SECAM
Panavision Genesis Tungsten Log (by Adobe)
ROMMI-RGB
SDTV NTSC
SDTV PAL
SMPTE-C
SP2100 Archival Matte_MK
SP2100 Archival Matte_PK
SP2100 Glossy Paper - PW_PK
SP2100 Premium Semigloss_PK
SP2100 Standard_MK
SP2100 Standard_PK
SP2100 Watercolor - RW_MK 
SP2100 Watercolor - RW_PK
Spyder Calibrated 090210
Viper FilmStream Daylight Log (by Adobe)
Viper FilmStream Tungsten Log (by Adobe)
Wide Gamut RGB

Euroscale Coated v2
Euroscale Uncoated v2
Generic CMYK Profile
Nikon CMYK 4.0.0.3000
Photoshop 4 Default CMYK
Photoshop 5 Default CMYK

Black & White
Generic Gray Profile
NikonGrayG1.8 v4.0.0.3000
NikonGrayG2.2 v4.0.0.3000
sGray

Print

Copies:   1

Position

Center image

Top:

Left:

Scale:

Scaled Print Size

Scale to Fit Media

Height:

Width:

Print Resolution: 300 PPI

Print Selected Area

Bounding Box

Cancel

Units:      cmMatch Print Colors

29.7 cm x 20.99 cm

Gamut Warning

Show Paper White

1.075

100%

16.93

25.46

1.393

Page Setup...

Printer:      EPSON Stylus Photo 2100
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Sometimes you don’t have a profile for  

a third party paper, and pretending it is 

another paper hasn’t produced results quite 

as beautiful as you had hoped. In this case 

Printer Manages Colors allows you to access 

the printer driver and, using an existing 

Epson paper as a starting point, adjust  

how the printer outputs colors. 

Getting into the printer driver is a bit awkward 

and varies a little depending on software 

version and operating system. On Windows 

the easiest way is to click the Page Setup 

button in Photoshop’s File > Print dialog. That 

should take you to your printer’s properties 

dialog box, which is actually the driver. Enter 

Custom mode, and click the Advanced button. 

Under Color Management, the No Color 

Adjustment option should not be set—doing 

so would turn off the printer driver’s color 

handling and is exactly the opposite of what 

Printer Manages Colors is supposed to do. 

Instead, choose Color Controls.

On a Mac, I find the easiest way is to click 

the Print button in Photoshop’s File > Print 

dialog. Choose Color Management from the 

drop-down box, click the little triangle next 

to Advanced, and the dialog box reveals a 

series of sliders.

Both Windows and Mac users can then 

adjust these sliders to tweak the color  

output and run a test print. If your eyes tell 

you that your paper needs less magenta or 

more green, drag the corresponding slider 

and then run another a test print. You’re 

moving boldly into the realm of guesswork 

and experimentation. 

   

Epson’s printer driver lets you start from a supplied paper 
profile and tweak the color output. On Windows the 
printer driver looks different, but has similar controls.

Visualizing Color spaces
Because the scientific L*a*b color system used to 
describe color spaces has three axes, it can be hard to 
visualize. In this book there are traditional illustrations 
(see page 71) since these clearly indicate the scope of 
different spaces, but to get the full picture you will need 
to use a program like ProfileEditor, which can produce 
2D and 3D comparisons of color spaces. You can move 
the view in three dimensions by dragging with your 
mouse, and the free demo mode will allow you to  
try the experience (www.xrite.com).

Print

Printer: EPSON Stylus Photo 1290

Color Management

Color Controls
ColorSync
No Color Adjustment

Photo-realistic

PDF               Preview Cancel             Print

Standard

All

1

1.8

0

0

0

-3

6

0

?

Collated

From:    1               to:    1

Presets:

Gamma:

Copies:

Pages:

Mode:

Advanced Settings:

Brightness

Contrast

Saturation

Cyan

Magenta

Yellow
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THESE OPTIONS ARE  known as the 

“Rendering intent,” a concept encountered  

on page 75, and they allow you to specify 

whether your computer should attempt  

to compensate for the printer’s gamut 

automatically, or simply print the colors  

that work as best it can and ignore the  

fact that some fall out of gamut.

Rendering intent, however, can also be part 

of the color workflow when you import your 

pictures from your camera or other device to 

your computer, especially if you have them 

set up in different color spaces. You can set 

Photoshop’s default rendering intent in the 

Color Preferences dialog introduced on page 

70, the same dialog where you set up your 

working profile.

As you might imagine, the best results when 

printing photographs are achieved by using  

a rendering intent designed to achieve 

continuous graduation of tones in the 

resulting prints. This is what the Perceptual 

option is for. The compromise is that not only 

the colors out of gamut need to shift, but all 

shades are also adjusted proportionally so 

that detail can be rendered in out-of-gamut 

areas. This is a compromise, but one well 

suited to photographic prints. Indeed it can 

be fairly likened to chemical processes since 

these too were proportionate rather than 

100% accurate.

That said, it is not always a compromise you 

need to make. If your image consists only of 

in-gamut shades, then there is no need to 

sacrifice the accuracy of Relative Colorimetric, 

and you can safely select this. Using the soft 

proofing tools to make a decsion will help  

you decide whether you should go for the 

accuracy of the Relative Colorimetric mode  

or the safety of Perceptual.

While a color management system can accurately 

describe input and output device’s color reproduction, 

that isn’t the whole story. The reason these systems 

exist is because every device is different and one 

cannot display the same range of colors as another. In 

digital printing, the issue is that the printer’s gamut—

even that of modern multi-ink printers—is generally 

significantly narrower than an RGB monitor. There are 

a number of options when compensating for this.

Rendering 
intent

Where rendering intent happens
The rendering intent choice is applied both when a file is 
converted into the working space, and when it is output 
to your printer. It is this latter occasion which garners 
more attention, since the printer’s gamut is likely the 
smallest of those involved so there is more potential  
for loss in the translation.

Input device: RGB 
digital camera

Working space 
(computer)

Translation 1 Translation 2

Output device: printer  
(likely CMYK space)

In a Relative Colorimetric 
conversion, the shades that  
are outside the gamut area are 
clipped and, rendered as the 
nearest in-gamut color. The result 
is areas of continuous tone in the 
print where there were areas of 
detail in the source.

Saturation Intent preserves the strongest possible 
conversions of fully saturated colors. It’s most useful 
when converting to a wider color space (the opposite 
of the scenario in the perceptual intent conversion) 
than the starting one, so those bright shades will  
be brighter still. This has more to do with display 
graphics than printed ones; for example converting 
from a web graphic to a known monitor. It’s not 
really suited to photos.

In a color space there is a line between black and 
white known as the white point. This gamut chart, 
which is a section half way from the brightest and 
the darkest points shows the two different mid 
grays, but it’s important to remember that this is 
merely one layer of a 3D-structure, with darker 
shades lower and lighter shades higher (see page 77). 
At the top is the white point.

In an Absoloute Colorimetric conversion, the white 
point is preserved, while in a Relative Colorimetric 
conversion the other colors are adjusted to 
compensate. Absoloute can lead to color shifts 
similar to the effects of incorrect white balance 
settings, while Relative compensates for 
characteristics of the target (off-white paper,  
for example).

Perceptual Intent

Saturation Intent

The original color space 
is in black, the target in 
yellow, and their white 
points marked.

In Absoloute Colorimetric, 
the white point is preserved 
in the same location in the 
new space.

In Relative Colorimetric, the 
colors are proportionately 
shifted to the new space’s 
white point.

With Perceptual rendering intent, 
all of the shades are adjusted  
so that they fit proportionally 
inside the narrower gamut, 
meaning that all the detail is 
preserved, but at the expense  
of color accuracy.

Original wide gamut

Narrow gamut

Narrow gamut

Original wide gamut

Out of gamut colors 
clipped

Out of gamut colors 
clipped



Soft 
proofing

EVEN THEN, THE  print may still not match 

the screen. It may then be tempting to apply 

a bit of guesswork and adjust the image so 

that although it looks wrong on screen, 

you’re pretty sure the print will now come 

out right. For instance, if the prints are 

generally too dark, you might lighten the 

picture in Photoshop so that the end result  

is acceptable. But it’s not a very satisfying 

method, and a rather hit or miss affair. That’s 

where “soft proofing” comes into its own.

Soft proofing is a feature of Photoshop and 

other imaging software where the picture is 

displayed as it should appear on the print.  

By choosing the printer profile, the user tells 

Photoshop the exact combination of printer, 

paper, and ink that will be used to output  

the print. When the user then enters soft 

proofing mode, the software then applies the 

profile’s information and adjusts the image’s 

on-screen appearance. In other words, it’s a 

clever kind of “print preview.”

It should be said that for the soft proofed 

image to be of use, there must be accurate 

profiles for both the monitor and the printer. 

If the screen is not properly calibrated, or  

the output device’s profile is inaccurate, 

Photoshop will not be able to make the 

on-screen preview look like the print.

80

In an ideal world, the print would come out  

of the printer looking just like it does on your computer 

screen. Unfortunately, it is not quite so easy because 

we are dealing with a series of devices and materials, 

and the monitor may have non-standard settings, as 

may the printer, the ink, or the paper. As we have seen, 

calibrating the monitor is the essential first step, and 

then a good profile for the printer, paper, and ink 

combination should get us close to good,  

predictable results. 

S
E

T
T

IN
G

 U
P

 Y
O

U
R

 C
O

M
P

U
T

E
R

81

Proof Setup allows you to  
choose the profile representing 
the printer, paper, and ink 
combination you want 
Photoshop’s soft proofing  
to simulate.

Ctrl/⌘+Y switches soft proofing on and off. 
Switch on Gamut Warning with Shift+Ctrl/⌘+Y.

View    Window    Help
Proof Setup
Proof Colors
Gamut Warning
Pixel Aspect Ratio

Zoom In
Zoom Out
Fit on Screen
Actual Pixels
Print Size

Screen Mode

Extras
Show

Rulers

Snap
Snap To

Lock Guides

New Guide...

Lock Slices
Clear Slices

Clear Guides

Pixel Aspect Ratio Correction
32-bit Preview Options...

⌘+

⌘Y

⌘-
⌘0
⌘1

⌘H

⌘R

⇧⌘;

⇧⌘Y

⌥⌘;
Customize Proof Condition

Custom

SP2100 Archival Matte_MK

Preserve RGB Numbers

Relative Colorimetric

Black Point Compensation

OK

Cancel

Load...

Save...

Preview

Display Options (On-Screen)

Proof Conditions
Device to Simulate:

Rendering Intent:

Custom Proof Condition:

Simulate Paper Color
Simulate Black Ink

Custom Proof Conditio

© 050617 015162 Derwentwater.tif @ 38.3% (RGB/16/SP2100 Archival Matte_MK) * x

38.25%                   ©3008 pixels x 2000 pixels (300 ppi)

Nikon Apple RGB 4.0.0.3000
Nikon Bruce RGB 4.0.0.3000
Nikon CIE RGB 4.0.0.3000
Nikon ColorMatch RGB 4.0.0.3000
Nikon D1 for NEF v1.0.0.3002
Nikon DBase for NEF v3.0.0.3001
Nikon MacMonitor 4.0.0.3000
Nikon NTSC RGB 4.0.0.3000
Nikon sRGB 4.0.0.3000
Nikon WinMonitor 4.0.0.3000
NTSC (1953)
PAL/SECAM
Panavision Genesis Tungsten Log (by Adobe)
ROMM-RGB
SDTV NTSC
SDTV PAL
SMPTE-C
SP2100 Archival Matte_MK
SP2100 Archival Matte_PK
SP2100 Glossy Paper - PW_PK
SP2100 Premium Semigloss_PK
SP2100 Standard_MK
SP2100 Standard_PK
SP2100 Watercolor - RW_MK
SP2100 Watercolor - RW_PK
Spyder Calibrated 090210
Viper FilmStream Daylight Log (by Adobe)
Viper FilmStream Tungsten Log (by Adobe)
Wide Gamut RGB

Euroscale Coated v2
Euroscale Uncoated v2
Generic CMYK Profile
Nikon CMYK 4.0.0.3000
Photoshop 4 Default CMYK
Photoshop 5 Default CMYK

Black & White
Generic Gray Profile
NikonGrayG1.8 v4.0.0.3000
NikonGrayG2.2 v4.0.0.3000
sGray
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What to do about it
What soft proofing often reveals is that the 

paper and ink cannot reproduce as wide  

a range or gamut of colors as the monitor 

can display. You then have to decide what,  

if anything, to do about it.

Once you know you have a problem, one 

approach is to adjust the image until the 

on-screen colors lie within the printer’s 

gamut. Switch on Photoshop’s Gamut 

Warning with Shift+Ctrl/⌘+Y and any colors 

that lie outside the printer’s gamut will be 

highlighted. You can then adjust the picture 

with a Saturation or Curves adjustment layer 

and bring its colors back within gamut. 

Unfortunately, while this gamut-based 

method tells you whether the colors will be 

printable, it doesn’t tell you how they will 

appear and can still lead to wasted prints.

The other method is to create a copy of the 

image file and arrange both copies on screen. 

One, the master file, is left untouched and 

shows how the picture should ideally appear. 
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Soft proofing can simulate the paper’s color. The left half is 
how the picture is supposed to look (aside from the gamut 
warning), while on the right the whites are subdued, 
indicating that they won’t look as bright when printed as 
on screen. You may want to apply a brightness adjustment 
layer to compensate for subdued whites on paper.

I like my Gamut Warning to be nice 
and brutal, but you can adjust it in 
Photoshop’s Preferences—it’s under 
Transparency and Gamut.

When you switch on the Gamut 
Warning, Photoshop highlights  
out-of-gamut areas. Notice that the 
document’s title area also shows the 
printer profile that it is currently being 
simulated—in this case a third party 
paper type.

Let’s look at the steps

5 Add adjustment layers, either via the icon in the Layers palette or via Layer > New 
Adjustment Layer, and adjust the “Soft Proof Copy” until its appearance matches the 

reference image. The most likely adjustments are Hue/Saturation, Levels, and Curves. Also 
pay attention to the adjustment layer’s blending mode—setting it to Color will ensure that 
the adjustment only affects the image color and not brightness.

Simulate Paper Color can be left on or off. 

Switched on, and you can assess the print’s 

dynamic range on-screen, but it will look 

washed out because the whites will no 

longer be as bright as your monitor can 

display. At first, this can be misleading, and 

leaving Simulate Paper Color turned off will 

usually be easier until you have experience 

of how the on-screen appearance translates 

into the results on paper.

3 Click on the original image’s name to activate it, 
and make sure Proof Colors is off.

2 Select Window > Arrange > Tile so that the 
two copies are side by side.

1 Choose Image > Duplicate. It can be a good idea 
to give the copy a name such as “Soft Proof Copy.”

The copy is viewed in soft proofing mode, 

and you add adjustments until it looks as 

close to the master reference image as it can. 

The process is not exact, but generally the 

print will be a much better image with the 

adjustments made while soft proofing. As a 

final step, I like to bundle all the Adjustment 

Layers into a Layer Set named so I can 

remember the adjustments’ purpose. I then 

drag it over to the master image and switch 

off its visibility, saving the master file and 

discarding the copy.

A couple of other settings are worth 

mentioning. Simulate Black Ink is usually  

left checked so the soft proof display lets  

you evaluate the print’s color gamut. 

4 Activate “Soft Proof Copy” and switch Proof Colors on.
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Software setup  
and resolution

OVER THE YEARS  Photoshop’s Print dialog 

has developed into a powerful tool and has 

combined into a single interface with other 

functions such as a soft proofed preview, 

borders, and resizing the image to fit the 

chosen paper size. Handy though this is, it 

doesn’t offer the same level of control as 

resizing the image before entering the Print 

dialog. If you use advanced sharpening 

methods, for instance, resizing through  

the Print dialog reduces the size of any 

sharpening haloes and so softens the image. 

It’s much better to set the print size through 

Image > Image Size and then set the 

appropriate sharpening.

Photoshop users who also use Lightroom or 

Aperture have another option —printing their 

PSD and TIFF files through those programs. 

This can save lots of time printing batches  

of images or printing different sizes from  

the same master file, and avoids any risk of 

flattening complex, multi-layer Photoshop 

files and losing the original data.

The Image > Image Size dialog is not that 

difficult to master. Look first at the Resample 

Image setting. If this is ticked, changing the 

pixels dimensions, document size, or 

resolution will mean that the actual image 

pixels will be changed or “resampled.” If it  

is not checked, changes to the document 

dimensions or resolution will not affect the 

image pixels. The option to choose depends 

on what you are doing. 
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Before we can make a print of the size we want, we 

need to translate the digital image’s pixels to paper’s 

inches or centimeters. The image’s height and width 

may be 3872 × 2592 pixels, 4208 × 2800, and so on, but 

the same pixels could be squeezed into a 5 × 7-inch 

print or stretched out to poster size. The resolution—

how many dots are printed per inch—is the missing 

link. Put it another way: printed size (inches) × 

resolution (dpi) = image pixels.
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Photoshop’s Print dialog has  
a setting that’s useful for quick 
resizing but not if you are 
seeking the finest quality. Saving the image as a “smart object” 

layer means that you can resize the  
file but the original image data is 
preserved, side-stepping the detail loss 
inherent in resampling multiple times.

For example, if you are printing a JPEG it may 

well have a resolution of 72dpi. That’s fine 

for viewing on screen, but not at all suitable 

for quality printing —it would be a big, low 

resolution image. A 36 × 53 inch (91 × 135 

cm) print would look fine if viewed from a 

distance, but not if you expect it to be viewed 

from close up. 300dpi would be a better 

choice for a normal size print, but you 

wouldn’t want to change the actual pixels —

you’re only correcting the resolution at 

which they are output. So in this case you 

would uncheck Resample.

On the other hand, let’s say you want to  

print a 3872 × 2592 pixel image and the 

resolution is already set at 300dpi for a 

normal print quality. With these settings as 

they are, the picture would print out at 12.9 

× 8.6 inches (36 × 22 cm). But if you wanted 

a 10.5 × 7 inch (27 × 18 cm) print, for instance, 

you would get better results by resampling  

the pixels and then applying the appropriate 

level of print or output sharpening. So leave 

Resample checked, set the dimensions in  

the Document Size, and then click OK.

Resampling means Photoshop has to 

recalculate and interpolate the pixel data, 

and you can choose from alternative methods 

at the bottom of the Image Size dialog. If you 

are making the image bigger, choose Bicubic 

Smoother. If you are reducing the image size, 

pick Bicubic Sharper and the resized image 

will keep more detail and appear sharper. 
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Printing with 
Aperture

AS A NEW  program for photographers, 

Aperture doesn’t offer all the different color 

management and printing choices that 

Photoshop provides. Like Adobe’s Lightroom, 

it doesn’t need to allow for old ways of 

working or for an enormously wide range  

of users. So there is no equivalent to 

Photoshop’s Color Settings dialog, no choice 

of Working RGB. The Mac operating system 

provides the color management, Aperture 

uses its own internal profile, and soft 

proofing is built into the File > Print dialog 

box. Some may regard this lack of choice  

as dumbing-down, but when all you want  

to do is print your photos, you don’t need 

irrelevant, confusing choices. It’s all  

about best practice, and including only  

those features that a photographer  

actually needs.

At the bottom of the View menu, you have 

two commands—Onscreen Proofing, which 

switches soft proofing on, and View > 

Proofing Profile, which is where you tell 

Aperture what kind of paper you want it  

to simulate. As you choose different papers, 

Aperture updates full screen images (not  

the thumbnails) to give you an idea of  

how the image will appear on paper.

File > Print initiates Aperture’s printing 

process and displays a three-column dialog 

box. The first column, Presets, lets you store 

frequently-used settings and recall them 

with a single click. So you can instantly 

switch to your settings for printing with  
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Apple’s Aperture was the first of that new wave of 

database-powered image editing programs that 

combined catalog functions with the ability to make 

most of the image adjustments photographers need to 

make. The goal is a more streamlined workflow,  

so Aperture can take pictures off the camera, adjust 

them, and print them. Even if a picture needs a quick 

trip to Photoshop for extra adjustments, you can 

then come back to Aperture for printing. 
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You can switch on Aperture’s soft 
proofing by selecting Onscreen 
Proofing at the bottom of the 
View menu, and change the 
profile via the Proofing Profile 
option beneath it.

Click the Print Settings 
button and you can get 
to your printer’s driver 
settings if you want 
advanced control over 
its color output.

Aperture’s File > 
Print dialog has 
three columns; 
presets for your 
favorite print setups, 
the middle column 
with the various 
print options, and  
on the right a soft 
proofed preview.

Preset Name

Single Images

Contact Sheet
Sample Contact Sheet Preset

Sample Single Image Preset

Copies & Pages

Print

Printer Selection

Copies:   1

Page:

Printer:

Paper Size:

Orientation:

Gamma:

Sharpen Amount:

Sharpen Radius:

Scale To: Fit Entire Image

0            x   0            cm.

DPI:   363

Layout Options

Border Options

Save As...             Save Hide Loupe           Save as PDF...          Preview

1 image selected - A4 (20.995x29.693 cm.)

Cancel           Print

Width: 1.439     cm.

Print Resolution

Use Best DPI

ColorSync Profile:

All

From:   1          to:  1

EPSON Stylus Photo

Print Settings...

A4

Best Fit

SP2400 Archival

Black Point Comp

1.00

20.995    x  29.

John’s Epson 2400 Delta Matt
John’s Epson 2400 Luster
John’s Epson 2400 FibaPrint
John’s Epson 2400 Hahnemuhle Rag
John’s Epson 4000 Hahnemuhle Rag

Show crop marks

Hide Toolbar ⇧T

⌥⇧H

⌥⇧P

P

Customize Toolbar...

Highlight Hot & Cold Areas

Quick Preview

Onscreen Proofing
Proofing Profile

Nikon NTSC RGB 4.0.0.3000
Nikon WinMonitor 4.0.0.3000
Nikon sRGB 4.0.0.3001
PAL/SECAM
ProPhotoRGB
SMPTE-C
SP2100 Archival Matte_MK
SP2100 Archival Matte_PK
SP2100 Glossy Paper - PW_PK
SP2100 Premium Semigloss_PK
SP2100 Standard_MK
SP2100 Standard_PK
SP2100 Watercolor - RW_MK 

Preset Name
Single Images

Contact Sheet
Sample Contact Sheet Preset

Last Preset

Print

Color Management

Color Controls
ColorSync
No Color Adjustment

Brightness 0

0

0

-5

5

0

Contrast

Saturation

Cyan

Magenta

Yellow

Advanced Settings:

Gamma:     1.8

Mode:    Photo-realistic

Cancel             Save

Show crop marks

Border Options

Save As...             Save Hide Loupe           Save as PDF...          Preview

1 image selected - A4 (20.995x29.693 cm.)

Cancel           Print

Width: 1.439     cm.

Sample Single Image Preset
John’s Epson 2400 Luster

John’s Epson 2400 Luster Copy

John’s Epson 2400 FibaPrint
John’s Epson 2400 Hahnemuhle Rag
John’s Epson 4000 Hahnemuhle Rag



a certain sharpening level, a 1.57 inch (4 cm) 

white border on Epson Premium Luster, on 

an Epson 2400. It’s a good idea to name  

your presets systematically so it’s easy to 

recognize what they do; I use printer model 

then paper name.

The middle column is where you choose  

how to print. Some of the settings are self-

explanatory, but one of the important ones  

is found just under where you choose the 

printer. It’s a button called Print Settings and 

provides access to the Epson printer driver. 

Switch it to Color Management and click the 

triangle next to the word Advanced, and you 

are given access color sliders so you can 

tweak the output. This can be useful if you 

don’t have a good profile for the paper you 

are using.
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The Loupe previews 
the results of 
Aperture’s output 
sharpening, but 
always base your 
sharpening on the 
final printed output.

The Print dialog’s ColorSync Profiles 
drop-down box lets you tell Aperture 
which paper you’re using and which 
profile it should use.

A little further down, the really important 

setting is ColorSync Profiles. This is where 

you choose the printer profile appropriate for 

the printer, paper, and ink combination you 

are using. Especially interesting is that when 

you choose a profile, Aperture updates the 

print preview at the right—the Print dialog 

box is effectively soft proofing.

There are also settings for print orientation, 

size, and borders, but the last controls I want 

to highlight are the two sliders for print 

sharpening. These are what is often called 

“output sharpening,” which is purely applied 

while printing to tweak the image for the 

chosen size of print. 

Aperture shows the results of sharpening  

in the Print dialog’s preview. Handy though 

this is, it is worth making the point that  

this preview is only an on-screen simulation,  

and the monitor has a much lower resolution 

than the print. It is not the same as examining 

the print itself and then considering whether 

just enough sharpening has been applied—but 

not so much that it is noticeable. In other 

words, regardless of the on-screen preview,  

it is something of a leap of faith.

I like to use Aperture’s Loupe to zoom in  

on the Print dialog box’s preview and see  

the results of sharpening in greater detail. 

Activate the Loupe using the Show Loupe 

button or by using the keyboard shortcut ~ 

(tilde). Then move the cursor to a critical 

area of the image—eyes for example—and  

fix the Loupe to that spot by using the 

keyboard shortcut Shift + ~ (tilde). You can 

now adjust the sharpening sliders and see 

their effect on key details.

Finally, let’s return to the Presets in the Print 

dialog’s left hand column. When you’ve just 

spent a few minutes getting the settings just 

right, it makes sense to save a preset so that 

next time you print it’ll be a breeze to repeat 

those settings. The more efficient you are 

with routine tasks, the more time and energy 

you have for the much more interesting 

artistic ones!
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Lightroom Templates

User Templates
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Printing with 
Lightroom

YOU INITIATE PRINTING  by going into 

Lightroom’s Print workspace. On the left  

are templates where you save favorite print 

settings and recall them when needed.  

You also have direct access to Lightroom’s 

“collections,” which serve as virtual folders 

and help you organize your pictures. 

To the right are a number of panels such  

as borders, orientation, or add a title. These 

options are pretty self-explanatory, so let’s  

go straight to those important for accurate, 

consistent color.
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Shortly after Aperture was released, Adobe responded 

with Lightroom and offered versions for both Mac OS and 

Windows. It shares Aperture’s objective of streamlining 

the image editing process and eliminating unnecessary 

options, so Lightroom uses its own wide gamut color 

space and gives the user no control over it. At the time of 

writing, Lightroom 2 does not have any soft proofing 

features. This omission, perhaps a tacit acknowledgement 

that only a small “elite” soft proof, means that printing  

in Lightroom is very straightforward indeed.
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Many photographers begin editing 
pictures in Lightroom, do additional 
detailed work in Photoshop, and 
then return to Lightroom for its  
slick printing interface.

Save your settings as 
templates—you’ll save 
yourself a lot of time  
if you do so.

The Image Settings  
panel contains a range  
of helpful layout settings.

Managed by Printer is a good 
choice when you’re using Epson’s 
own paper.

At the bottom of the left panel are two 

buttons. Page Setup is where you can choose 

paper size, while Print Settings accesses the 

printer driver. However, the really important 

settings are in the Print Job panel at the 

bottom of the right panel. Print Sharpening 

gives you three straight choices of output 

sharpening—Low, Standard, or High—and 

does not output a potentially misleading 

preview. You should examine the print, not 

the monitor’s preview, and then decide if  

the sharpening level is suitable to the image. 

Generally, the setting should be left at 

Standard, while Low and High are best 

reserved for images with special 

requirements. For instance, a portrait of a 

child may well look best with only a small 

amount of sharpening.

There’s also a setting for 16-bit output. If 

your printer has 16-bit printing, it’s worth 

trying and placing 8-bit and 16-bit prints side 

by side. In theory there should be smoother 

The Color Management drop-
down box also lists all the print 
profiles on your computer.

tones, but it will be interesting—impressive, 

even—if you can spot the difference.

Next is the critically-important Color 

Management setting, and Lightroom defaults 

to Managed by Printer. Leaving it set to this 

option will mean that the printer driver 

controls the output, so you have to make 

sure you set the correct paper choice either 

in Print Settings or after you press Print.

However, Lightroom was born in the era  

of ICC profiles, and the Color Management 

drop-down box also lists all the print profiles 

on your computer. Choose one of these, hit 

Print, and switch off the printer driver’s Color 

Management in the Printer’s own dialog.

Until Lightroom includes soft proofing, there’s 

not a lot more to be said about setting it up 

for printing. But that’s the idea—it’s intended 

to be that straightforward and it certainly 

manages it.
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